
 How To Use This Gimp Template

English (In Spanish at the end – En Español al final)

This Special Gimp Template that I created for this model will allow you to quickly edit it 
and create your model with as many colors as you want. This file has several layers with all 
the body color parts that you can quickly use to change them with full blocking masks already 
created so you do not affect any other parts of the car unless you want to do so and I will tell 
you here the basics of what you have to do in The Gimp in order to change the colors of these 
parts as you wish. The original PDF files that I created for this model are completely in vector 
(lines) but even if this Gimp file has been created in pixels (image dots) it has been created at 
exactly the same page size of 8.5” x 11” (letter size) so all you have to do is to print it from 
The Gimp using the same procedure that I recommended for the rest of the model in the PDF 
file that I included titled HowToPrintThisModel. It is important that you maintain the page size 
because that way the parts will remain compatible with the rest of the model. This file was 
created at a high resolution of  300 dots per inch to maintain a high quality.  This doesn't 
pretend to be a full tutorial on how to use The Gimp, it's just to give you the basics that you 
will need to change the colors of the parts and paint over them with the blocking masks that I 
created for them. For additional help you can refer to The Gimp website itself and or Gimp 
related forums.

First for those who don't  now, The Gimp is an open source program (created by the 
community of PC users) that is available completely free of charge and that doesn't have any 
adware or spyware of any kind. You can download it at the following address at this moment:

http://www.gimp.org/

If the address changes in the future just do a web search for The Gimp and you will 
probably find it, it's been available almost forever so just try.

OK after installing the software open the file and observe the layers in the layers pane to 
the right (if you don't see them click in the tab with the icon that looks like a few white pages 
stacked on top of the other). You will see the layer named Page 1 Colored visible (to make a 
layer visible or invisible you left click to the left of the layer to toggle the eye icon on or off). By 
left clicking on a layer you make it the active layer (The gray square around the name of the 
layer) so that means that that is the layer that becomes active and the one that you can 
manipulate or edit at the moment. Now there are several layers above that one, the one right 
above it is the same page (Page 1) but with white parts and the other layer right above that 
one is again the same page but with the parts in black. The other six layers above are the 
same deal but for pages 2 and 3. That gives you a choice of colored parts or the two most 
important values (that's how black and white are called) to give you a wide choice of options 
to modify your parts, now the one that will interest you the most perhaps is the colored one 
but don't worry because it's just blue cause you will be able to change the hue to any hue that 
you want with a few simple steps.

Left click in the tab next to the right of the layers tab (the one that has an icon that looks 
the same as the layers icon but with  red, green and blue colors).  Now you can see the 
channels pane and you will see below, the three blocking masks that I created for you that will 
allow you to affect only the colored parts of the car without affecting anything else (The ones 

http://www.gimp.org/


called Page 1 Full Mask, Page 2 Full Mask, etc. which correspond to one of the three pages 
of parts that I created (remember there are 3 pages only, there are 9 layers - actually 10 if you 
include the white background, but it's just that there are colored, white and black for every 
one of the 3 pages and that makes 9 layers, Ok?). This is what you do to select the mask and 
put it into action: make a click with the right mouse button on the layer for the page that you 
want to use (in this case it will be the bottom one called Page 1 Mask which corresponds of 
course to the page 1 parts) you will see a drop down menu that appears with several choices. 
Now select the one called Channel to Selection and you will notice that a selection mask has 
appeared over your picture represented by a lot of moving dashed lines, this is a selection 
mask that will allow you to paint over your picture but changing only those parts that are in 
colors (the paint parts of the car) it will  also allow you to change those parts with picture 
adjustments controls or filters or anything else that you want too change in those parts only. If 
you make any mistake or if you want to roll back any changes that you made use Ctrl-Z to 
undo the change or go to the Edit menu and select undo (you can undo multiple times). Now 
that you have your selection active you can change the colored layer that you had previously 
selected by selecting it again. Click the layer tab again (the stacked white papers icon) and 
select the layer named Page 1 Colored which corresponds to the selection you just made by 
left clicking on it. If you prefer you can do something before the changes, right click on the 
layer and in the drop down menu select Duplicate Layer, this will create a copy of that layer 
right above it that you can work on and delete later on if you want to without affecting your 
original template at all. (If you don't want to worry of damaging the template you can save a 
copy of the original file and if you don't you can always download it again). If you want to 
erase a  selection  go  to  the  Select  menu  and  choose  None or  press  Shift+Ctrl+A in  the 
keyboard, yeah those three keys simultaneously.

Now after duplicating the layer or not, with that layer selected and with the selection 
mask active (the animated dashed lines) go to the Colors menu and select Hue-Saturation 
and you will see a window that appears with the Hue, Lightness and Saturation controls close 
to the bottom of the window. The one that will make the most dramatic change is the first one 
of those three sliders, the Hue control. Make sure that the small selection box titled Preview 
located in the lower left corner of the window is selected and move that slider to the left or the 
right as much as you want and then see what happens to your parts, cool ehh? As you can 
see now, you will have an unlimited number of colors for your Ford parts. You can also move 
the second slider (Lightness) and that will make your color look darker or lighter and the third 
one (Saturation) will make the colors more saturated (more vivid of course) or duller. Now 
remember that if you want the other two pages to have the same colors you have to write 
down the amount of changes that you did to the first page and those are the small white 
boxes to  the  right  of  the  sliders that  will  show you the  value of  those sliders in  precise 
numbers and by the way you can also write those numbers directly in those small boxes with 
your keyboard by selecting them with a left mouse click first and you can also increase or 
decrease the numbers with the small arrows to the right of those number boxes. Write down 
the values of those three white boxes and apply them exactly to the other colored pages (the 
layers with the blue colored parts). Now click OK and those changes will be performed to your 
layer.

 Another thing that you can do is to create a transparent layer right above the one that 
you want  to  affect  and with  your  selection active (the moving dashed lines)  paint  in that 
transparent  layer  by  using  the  paint  tools  like  the  brushes  or  the  others.  To  create  a 
transparent layer above the selected layer make sure first precisely that the layer you want is 



selected and then click the small white page icon at the bottom left of the layers pane (the one 
to the left of the two up and down green arrows) with the left mouse button. You will see a 
dialog box that appears with several choices, now in the area labeled Layer Fill Type select 
the radio button called Transparency and click the OK button at the bottom of the dialog box. 
You  will  see  a  layer  above  your  previously  selected  layer  called  New  Layer  and  it  is 
transparent so you can paint in it with your blocking mask (your selection) and it will not affect 
the layer below with your parts until you are done and decide to flatten the picture (turn all 
your layers into one – optional if you save in .xcf format but not if you want to save in .jpg or 
.png format [Gimp flattens a picture forcedly when it saves to a file format such as those 
anyway but  that  doesn't  mean that  it  destroys  your  layers  that's  just  temporarily  while  it 
saves]) or if you want to save it without flattening because The Gimp file format will retain the 
layers (if you save it in The Gimp .xcf format) or when you print the image. There is a gray 
arrow inside a blue box at almost the top of the layers pane to the right (right below the small 
box with the other arrow that points to the left). If you click in that blue box with the left mouse 
button you will see a drop down menu that appears with lots of options. Those are the layer 
modes and what they do is that they allow you to “mix” your currently selected layer (in this 
case the transparent layer that you created to paint in it) with anything below that layer that is 
visible. They will take what you have painted there and “mix it” with the layers below that one 
in many different ways, play with it if you want to so you can see how it looks OK? The one 
that probably matters the most of these modes is the one called Overlay because this one is 
the one that sort of mixes better what you have in that layer with the layers below, you might 
want to try that one. Observe the horizontal slider that is below the gray arrow in the blue box 
that  was  just  mentioned  and  that  is  named  to  the  left  as  Opacity,  this  will  change  the 
transparency of any selected layer. Of course what it's already fully transparent in a layer will 
not change but whatever you put in a layer or paint in a layer can become as transparent as 
you want,  play with this also so you get the hang of it.  Every layer will  retain a different 
transparency setting that you can change any time you want by using this slider.

After you finish you can either print your new “customized” parts or save the changes to 
either a Gimp .xcf file that retains all those layers or save the pages to separate pages as .jpg 
files or .png files or any other image format of your choice and after that you can even create 
a PDF with them in software such as Inkscape (another free open source software that draws 
but with lines instead of pixels like The Gimp and something that should be explained here is 
that  even if  those programs use lines to  draw they can incorporate pixel  images in their 
designs and mix them with lines and that the PDF format can contain both type of designs, 
line based designs [vectors] and dot based designs [pixels] at the same time just like those 
programs) you can download Inkscape at:  http://www.inkscape.org You can do this  also in 
similar commercial software like CorelDraw or Adobe Illustrator of course. Once your images 
are imported in a software like that you can save them or export them as a PDF file from 
there, just make sure that you picture retains the 8.5” x 11” (letter size), you have to create a 
letter size page first in one of those programs and then make sure that the image that you 
imported fills the page completely from corner to corner without leaving gaps. Don't leave 
margins because I already created a generous margin (the white area around the colored 
borders) around your parts images for the purpose of staying inside the printable area of your 
printer. Another possible choice for creating a PDF of your image is to use CutePDF Writer 
which is also free and available from: http://www.cutepdf.com/ (the free version is good enough 
for most things). This is what is called a virtual printer which means that it will install in your 
computer as a printer driver and you can select it like it was another printer but instead of 
printing to a real printer it “prints” to a PDF file, it will ask you for a file name and a directory 

http://www.cutepdf.com/
http://www.inkscape.org/


and then it will save your work as a PDF file. This software works with any software that prints 
including a web browser and I create many PDFs with it, it's a very good piece of software to 
have in your toolbox of software and you can print from The Gimp and create a PDF page of 
your image (remember to set the page to letter size in the Gimp, in the File menu select Page 
Setup and in the dialog box that appears select the paper size to Letter, the orientation to 
Portrait and all the Margins to 0) before printing to CutePDF writer and by the way this is 
something that you have to do before printing (in a regular fashion) in The Gimp anyway. For 
CutePDF Writer to work it needs a library called Ghostscript that you have to install first but 
it's also free and available from the CutePDF Writer website. And that's all  for this simple 
tutorial. I hope that it helps you create the model that you want.

   Sincerely, 
Angel David Guzmán – PixelOZ

Como Usar Esta Plantilla Para El Gimp

Español

Esta plantilla que he creado para este modelo le permitirá editarla rápidamente y crear 
su modelo con tantos colores como desee. Este archivo tiene varias capas con todas las 
partes de carrocería  en colores que usted puede usar  rápidamente para cambiarlas con 
mascarillas de bloqueo ya creadas para que no afecte ninguna otra parte del vehículo a 
menos que usted quiera hacerlo así y le diré aquí lo básico que tiene que hacer para en El 
Gimp poder cambiar los colores de estas partes como usted lo desee. Los archivos originales 
en PDF que yo creé para este modelo están completamente en vector (líneas) pero aún si 
este archivo de Gimp está creado en pixeles (puntos) se ha creado al mismo tamaño de 
página de 8.5” x 11” (tamaño carta) así que todo lo que tiene que hacer es imprimirlo desde 
El Gimp utilizando el mismo proceso que recomendé para el resto del modelo en el archivo 
PDF que  incluí  titulado  ComoImprimirEsteModelo.  Es  importante  que usted  mantenga el 
tamaño de página porque de esta forma las partes se mantendrán compatibles con el resto 
del  modelo.  Este  archivo  se  creó  en  alta  resolución  de  300  puntos  por  pulgada  para 
mantener una alta calidad. Esto no pretende ser un tutorial completo de cómo usar El Gimp, 
es solo para darle lo básico que usted necesitará para cambiar los colores de las partes y 
pintar sobre ellas con las mascarillas de bloqueo que creé para ellas. Para ayuda adicional 
puede referirse a la página de El Gimp misma o los foros relacionados con El Gimp.

Primero, para esos que no lo saben, El Gimp es un programa de código abierto (creado 
por la comunidad de usuarios de computadoras) que está disponible completamente libre de 
cargos y que no contiene programas de anuncios o programas espías de ninguna clase. 
Puede descargarlo en la siguiente dirección de la red al momento:

http://www.gimp.org/ 

Si la dirección cambia en el futuro solo haga una búsqueda de la red para “The Gimp” 
(El Gimp) y probablemente lo encontrará, ha estado disponible desde hace casi siempre así 

http://www.gimp.org/


que solo inténtelo.

Entonces después de instalar el programa abra el archivo y observe las capas en el 
panel de capas hacia la derecha (si no las ve de un clic izquierdo al icono en que aparecen 
unas pocas páginas blancas una encima de la otra). Usted verá la capa llamada Page 1 
Colored (Página 1 Coloreada)  visible  (para  hacer  una capa visible  o  invisible  de  un clic 
izquierdo a la izquierda de la capa para activar o desactivar el icono del ojo). Haciendo un clic 
izquierdo en una capa la hace la capa activa (El rectángulo gris alrededor del nombre de la 
capa) y eso significa que esa capa se convierte en la capa activa y la que usted puede 
manipular o editar al momento. Ahora, hay varias capas sobre esta, la primera que tiene 
arriba es la misma página (Page 1 - [Página 1]) pero con las partes blancas y la otra capa 
sobre esta es de nuevo la misma página pero con las partes en color negro. Las otras seis 
capas encima de estas son la  misma cosa pero para las páginas 2 y  3.  Eso le  da una 
selección de partes coloreadas y los dos valores más importantes (así es como se le llama al 
blanco y al negro) para darle una amplia selección de opciones para modificar sus partes, 
ahora la que tal vez le interese más es la coloreada pero no se preocupe de que sea solo 
azul porque usted podrá cambiar el tono a cualquier tono de color que usted desee con unos 
simples pasos.

Haga un clic izquierdo en la solapa justo al lado derecho de la solapa de capas (la que 
tiene un icono igual al de la solapa de capas pero en colores rojo, verde y azul) Ahora puede 
ver el panel de los canales y verá un poco mas abajo en este panel las tres mascarillas de 
bloqueo que he creado para usted que le permitirán afectar solamente las partes coloreadas 
del carro sin afectar nada más (Los canales llamados Page 1 Full Mask (Mascarilla Completa 
de  Página  1),  Page  2  Full  Mask  (Mascarilla  Completa  de  Página  2),  etc.  las  cuales 
corresponden a una de las tres páginas que creé (recuerde solo hay 3 páginas, hay 9 capas 
– bueno de hecho hay 10 si incluye la que contiene el trasfondo blanco, pero es que hay 
capa coloreada, capa blanca y capa negra para cada una de las tres páginas y eso hace 
nueve capas, ¿esta bién?). Esto es lo que tiene que hacer para seleccionar la mascarilla y 
ponerla en acción: haga un clic con el botón derecho del ratón en la capa para la página que 
desea usar (en este caso será la que está en el fondo llamada Page 1 Mask que corresponde 
por supuesto a las partes de la página 1) verá un menú descendiente que aparece con varias 
opciones.  Ahora  seleccione la  que se  llama Channel  to  Selection  (Canal  a  Selección)  y 
notará que una mascarilla de selección ha aparecido sobre su imagen representada por una 
serie de líneas entrecortadas en movimiento, esto es una mascarilla de selección que le 
permitirá pintar sobre su imagen pero cambiando solo esas partes que están en colores (las 
partes pintadas del carro) le permitirá cambiar esas partes con controles de ajuste de imagen 
o filtros o cualquier otra cosa que usted desee cambiar en esas partes solamente. Si comete 
algún error o si desea deshacer cualquier cambio que haya realizado use las teclas de Ctrl+Z 
para deshacer el  cambio o vaya el  menú de Edit  (Editar)  y seleccione Undo (Deshacer) 
(puede deshacer múltiples veces).  Ahora que tiene su selección activa puede cambiar la 
capa coloreada que había seleccionado previamente seleccionándola otra vez. Haga un clic 
izquierdo  en  la  solapa  de  capas  (el  icono  de  los  papeles  blancos  uno  sobre  el  otro)  y 
seleccione la  capa llamada Page 1 Colored (Página 1 Coloreada)  que corresponde a la 
selección que usted acaba de hacer haciendo un clic izquierdo en ella. Si lo prefiere puede 
hacer algo antes de los cambios, haga un clic derecho en la capa y en el menú descendiente 
que aparece seleccione Duplicate Layer (Duplicar Capa), esto creará una copia de esa capa 
justo encima de ella en la que podrá trabajar y luego borrar si lo desea sin afectar la plantilla 
original en lo absoluto. (Para no preocuparse de dañar la plantilla, usted puede guardar una 



copia de esta antes de empezar a trabajar en ella y si no lo hace puede volverla a descargar 
del Internet). Si desea borrar una selección vaya al menó de Select (Seleccionar) y escoja 
None  (Ninguna)  o  presione  las  teclas  de  Shift+Ctrl+A,  o  sea  estas  tres  teclas 
simultáneamente.

Ahora después de duplicar la capa o no, con esa capa seleccionada y con la mascarilla 
de selección activa (las líneas entrecortadas animadas) vaya al menú de Colors (Colores) y 
seleccione Hue-Saturation (Tono-Saturación) y usted verá una ventana que aparece con los 
controles titulados Hue, Lightness y Saturation (Tono, Iluminación y Saturación) cerca del 
fondo de la ventana. El que hará el cambio más dramático es el primero de los controles 
deslizantes,  el  control  de  Hue.  Asegúrese de que la  pequeña caja  de  selección  titulada 
Preview (Ver de Antemano) a la esquina inferior izquierda de la ventana está seleccionada y 
mueva ese control de Hue hacia la izquierda y la derecha y vea lo que le sucede a sus 
piezas, ¿nítido ehh? Como usted puede ver ahora, tendrá un número ilimitado de colores 
para sus piezas de carro Ford. También puede mover el segundo control (Lightness) y eso 
hará que su pieza tenga un color más claro o más oscuro y el tercer control (Saturation) hará 
los  colores  mas  intensos  o  más opacos.  Ahora  recuerde  que si  desea  que sus  otras  2 
páginas tengan los mismos colores tiene que apuntar en algún lado las cantidades de los 
cambios que les hizo a la primera página y esas son las pequeñas cajas blancas al lado 
derecho de los controles deslizantes que le mostrarán el valor de esos controles en números 
precisos y de hecho puede escribir números directamente en esas cajitas con su teclado 
seleccionándolas primero haciendo un clic  con el  botón izquierdo del  ratón sobre ellas y 
puede incrementar o disminuir los números con las pequeñas flechas a la derecha de esas 
cajas. Escriba los valores de esas tres cajas blancas y aplíquelos exactamente igual a las 
otras dos páginas coloreadas (las capas con las partes coloreadas en azul). Ahora de un clic 
izquierdo en el botón de OK y esos cambios serán aplicados a su capa.

 Otra cosa que puede hacer es crear una capa transparente justo encima de la capa que 
quiere afectar y con su selección activa (las líneas entrecortadas en movimiento) pintar en 
esa capa transparente con las herramientas de pintar como la brocha y las demás. Para 
crear  una  capa  transparente  encima  de  la  capa  seleccionada  precisamente  asegúrese 
primero  que  la  capa  que  desea  afectar  esté  seleccionada  y  entonces  de  un  clic  en  el 
pequeño icono blanco en forma de página abajo y a la izquierda del panel de las capas (el 
que está a la izquierda de las dos flechas verdes que apuntan hacia arriba y hacia abajo) con 
el  botón  izquierdo  del  ratón.  Usted  verá  una  caja  de  diálogo  que  aparece  con  varias 
opciones, ahora, en el área titulada Layer Fill Type (Tipo de Relleno de la Capa) seleccione el 
botón redondo que se llama Transparency (Transparencia) y haga un clic izquierdo en el 
botón de OK en la parte inferior de la caja de diálogo. Verá una capa justo arriba de la capa 
que había seleccionado anteriormente llamada New Layer y es transparente así que puede 
pintar con su mascarilla de bloqueo (su selección) y no afectará la capa de abajo  que tiene 
sus piezas hasta que termine y decida aplanar la imagen (convertir todas las capas en una 
sola – opcional si usted guarda en formato .xcf pero no cuando guarda en formato .jpg o .png 
[El Gimp aplana una imagen forzosamente cuando guarda a uno de esos formatos de todas 
formas aunque eso no quiere decir que destruye sus capas, eso es al momento de grabar en 
esos formatos y es temporalmente]) o si quiere guardar sin aplanar porque el formato de El 
Gimp retendrá  las  capas (si  guarda en formato .xcf  de Gimp) o  cuando uno imprime la 
imagen. Hay una flecha gris dentro de una caja azul en casi el tope del panel de las capas 
hacia la derecha (justo abajo de la caja con otra flecha que apunta hacia la izquierda). Si 
usted hace un clic izquierdo en esa pequeña caja azul aparecerá un menú descendiente con 



muchas opciones. Esos son los modos de las capas y lo que hacen es que le permiten 
“mezclar” su capa seleccionada al momento (en este caso la capa transparente que creó 
para pintar en ella) con cualquier cosa visible que esté debajo de la misma. Tomará lo que 
usted pintó ahí y lo “mezclará” con las capas debajo de esa en muchas formas diferentes, 
juegue con esto si lo desea para que vea como sale, ¿está bien? El que probablemente 
importa más de estos modos es el que se llama Overlay (Capa Sobrepuesta) porque este es 
el que mejor tiende a mezclar lo que tiene en esa capa con las capas de abajo, puede querer 
tratar de usar ese. Observe el control deslizante horizontal que esta debajo de la flecha gris 
en la caja azul que se acaba de mencionar y que está nombrado a la izquierda como Opacity 
(Opacidad) este cambiará la transparencia de cualquier capa seleccionada. Por supuesto lo 
que ya está completamente transparente en una capa no lo tocará pero lo que usted ponga 
en ella o pinte en ella se volverá tan transparente como usted lo desee, juegue con esto 
también para que vaya agarrándole el uso. Cada capa retendrá un nivel de transparencia que 
podrá volverse a cambiar cuando usted lo desee usando este control.

Después de que termine puede imprimir sus nuevas piezas “personalizadas” o guardar 
los cambios a el formato .xcf de Gimp que puede retener todas esas capas o guardar las 
páginas a páginas separadas en formato .jpg o formato .png o cualquier otro formato de 
imágenes  que  usted  prefiera  y  después  de  esto  hasta  puede  crear  un  PDF con  estas 
imágenes en programas tal  como Inkscape  (otro  programa gratis  de  código  abierto  que 
dibuja pero con líneas en vez de pixeles como El Gimp y una aclaración aquí es que aunque 
estos otros programas dibujan en líneas pueden incorporar imágenes de puntos también en 
sus  diseños  y  mezclarlas  con  diseños  de  líneas  también  y  que  el  formato  PDF  puede 
contener ambos tipos de diseños, diseños en líneas [vectores] y diseños en puntos [pixeles] 
a  la  misma  vez  como  en  esos  programas)  puede  descargar  el  Inkscape  de  gratis  en 
http://www.inkscape.org Puede hacer esto también por supuesto en programas comerciales 
similares como CorelDraw o Ilustrador de Adobe. Una vez sus imágenes esté importadas en 
un programa como esos puede guardarlas o exportarlas a un archivo PDF desde ahí, solo 
asegúrese de que su imagen retenga el tamaño 8.5” x 11” (tamaño carta), usted tiene que 
crear una página tamaño carta primero en uno de esos programas y entonces asegurarse de 
que la imagen que usted importó llene la página completa de esquina a esquina sin dejar 
hueco. No deje márgenes porque yo ya creé un margen generoso (el área blanca alrededor 
de los bordes coloreados) alrededor de las imágenes de las piezas con el propósito de que 
se queden dentro del área de impresión de su impresora. Otra posible opción para crear un 
PDF de su imagen es utilizar el programa CutePDF Writer el cual es también gratis y está 
disponible en:  http://www.cutepdf.com/ (la versión gratuita es muy buena para casi  todo). 
Esto  es  lo  que  se  llama  una  impresora  virtual  lo  cual  significa  que  se  instala  en  su 
computadora como un programa de impresora y  puede seleccionarlo  como si  fuera otra 
impresora pero en vez de imprimir  a una impresora real  “imprime” a un archivo PDF, le 
preguntará  por  un  nombre  que  ponerle  al  archivo  y  el  directorio  en  donde  guardarlo  y 
entonces guardará su trabajo como un archivo PDF. Este programa trabaja con cualquier 
programa que imprima incluyendo su navegador de la red y yo he creado muchos PDF con 
el,  es un buen programa para tener en su caja de herramientas de programas y puede 
imprimir desde El Gimp y crear una página PDF de su imagen (recuerde poner su página a 
tamaño carta en El Gimp, en el menú de File (Archivo) seleccione Page Setup (Formatear 
Página) y en la caja de diálogo que aparece seleccione el tamaño carta del papel (Letter 
Size), la orientación a Portrait (Retrato) y los Margins (Márgenes) a 0 antes de imprimir a 
CutePDF Writer y de hecho esto de poner la página a tamaño carta es algo que debe de 
hacer siempre antes de imprimir (en la forma tradicional) en Gimp de todas formas. Para que 

http://www.cutepdf.com/
http://www.inkscape.org/


CutePDF funcione  necesita  una  librería  que  se  llama Ghostscript  que  tiene  que  instalar 
primero pero esta también es gratis y se consigue en la misma página en donde se consigue 
CutePDF Writer. Y eso es todo con este simple tutorial. Espero que lo ayude crear el modelo 
que usted desea.

  Sinceramente,
Angel David Guzmán – PixelOz


